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Summary 
The purpose of this whitepaper is to document a prescriptive method for Windows 7 hard 
disk Recovery Solution, one that reinstalls Windows 7 to its state at the time it left the 
factory.  

Customers that wish to restore their systems only need to use the Advanced Recovery 
Method inside Windows 7 or press F8 while the system is booting and choose the Repair 
Your Computer option.  

Intended Audience 
This procedure is specifically targeted for Original Equipment Manufacturers (OEMs), and 
applies only to all Windows 7 operating systems. 
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Step 1.0: Prepare your lab environment 
In this step you will set up your lab environment, which includes installing the latest 
Windows 7 OPK tools onto your designated technician computer. You will use a USB hard 
drive to move files between computers.  

Prerequisites 

1. A machine dedicated as your technician computer 
2. A machine dedicated as your reference computer 
3. A machine dedicated as your master computer 

 
Computer Minimum Specifications: 

o Windows 7 operating system 
o Processor: 1.5 GHZ or better 
o Memory: 2 GB or better 
o Video: DirectX 9.0 capable and WDDM 1.0 Driver support, 128 MB graphics 

memory 
o HDD: at least 20 GB of free space 
o DVD: Reader 

 
4. Windows 7 OPK Product DVD 
5. Windows 7 Product DVD 
6. CD-ROM and/or DVD-ROM media 

7. USB hard drive; the size must be at least 15 gigabytes (GB) or larger 
8. USB flash drive (UFD); the size must be at least 2 gigabytes (GB) or larger 
9. Microsoft Office 2010 OPK 
10. (Optional) 3rd party drivers and applications 
11. OEM logo for System Control Panel, 172 x 100 pixels, bitmap image 

12. OEM logo for OOBE, a 32-bit portable network graphics (.png) file; 240x100 pixels 
13. Custom background image for Windows Welcome. 

 
Note: This image must be sized appropriately for the resolution of the computer 
screen and must not exceed 250 kilobytes (kb). For a custom image to be used, the 
directory %WINDOWS%\System32\OOBE\Info\Backgrounds must contain either an 
image that is specified as the default image, or an image that matches the screen 
resolution. If a default image is used, the default filename must be: 

o backgroundDefault.jpg 

The filenames for images to be used for specific screen resolutions are: 

o background768x1280.jpg 

o background768x1360.jpg 

o background900x1440.jpg 

o background960x1280.jpg 

o background1024x768.jpg 

o background1024x1280.jpg 

o background1280x768.jpg 
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o background1280x960.jpg 

o background1280x1024.jpg 

o background1360x768.jpg 

o background1440x900.jpg 

o background1600x1200.jpg 

o background1920x1200.jpg 

14. Custom user tile which must be a bitmap (.bmp) file and the size should be 128 x128 
pixels. 

1.1: Install Windows OPK tools 

In this step, you will install the Windows OPK tools onto your designated technician 
computer. 

Important: You must uninstall any previous version of the Windows OPK. 

1. From your running technician computer, insert the Windows 7 OPK. 
Windows should automatically start the OPK setup program.   

Note: If the OPK setup does not start, you can manually start the installation. From 
the Run command type D:\StartCD.exe where D: is your DVD-ROM drive.  
 

By default, Setup creates the following directory structure: 

C:\Program Files\Windows OPK\Docs\ 

C:\Program Files\Windows OPK\Recovery\ 

C:\Program Files\Windows OPK\Samples\ 

C:\Program Files\Windows OPK\SDKs\ 

C:\Program Files\Windows OPK\Tools\ 

1.2: Create a Distribution Share on the Technician 
Computer 

 The following procedures will create a distribution share used to store the custom 

installation files and the Windows Vista installation files. For ease of network access in a 

closed network environment, these procedures configure permissions for the share and 

security of the distribution folder to allow access to everyone. For your environment, 

configure the permissions for the share and security of the distributions share appropriately. 

To create a distribution share, complete the following: 

1. Click Start, click All Programs, click Microsoft Windows OPK, and then click 

Windows System Image Manager.   

2. In the Distribution Share pane of the Windows System Image Manager, right click 

on the Select a Distribution Share. 

3. Click on Create Distribution Share. 



Creating a Windows 7 Hard Disk Recovery Solution 
 

Shiningintl Technology     www.shiningintl.com Page 7 
 

4. Navigate to the folder you want to use as a distribution share or type in the path to 

the folder name you want to use as a distribution share. 

Note: Throughout this document, we’ll reference C:\WinBits as the name of our 

distribution folder. 

If the folder doesn't exist, the folder will automatically be created. 

5. Click Open. 

1.3: Add Drivers to your Distribution Share (Optional) 

In this step, you will add any out-of-box drivers needed for your custom installation. There 
are three types of driver installations supported through an answer file: In-box and out-of-
box (.inf, .exe or .msi). In this step, you add an out-of-box (.inf) driver to your new 
distribution share under the \Out-of-box drivers. 

To learn more about distribution shares, see the "Understanding Distribution Shares and 
Configuration Sets" topic in the OPK.chm. 

1. Create an empty distribution share structure where you will add any custom out-
of-box drivers. The name will be \Winbits. 

2. Copy the out-of-box driver files (.inf) to 

C:\Winbits\Out-of-Box Drivers\<Driver Folder>. 

Note: Copy only .inf based drivers to this folder. 

The <Driver Folder> designates the folder name of your driver. If you have 
multiple drivers to add to this directory, it is recommended that you create 
subdirectories for each driver. This ensures that there are no conflicts for 
drivers with the same file name. 

1.4: Add Microsoft Office 2010 to your Distribution Share 

In this step, you will add Microsoft Office 2010 to the distribution share. You will copy the 
Office 2010 bits to your configuration set. 

To add Microsoft Office 2010 to your distribution share, complete the following steps: 

1. On the technician computer, start Windows Explorer, and navigate to 
c:\WinBits\$OEM$ Folders. 
 

2. Using Windows Explorer, create the following folder structure:  

c:\WinBits\$OEM$ Folders\$1\Office 2010 

1. Insert the Office 2010 OPK DVD into the DVD drive of your technician computer. 
 

2. Open a command prompt with administrative privileges elevated. 
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3. Change directory to the location of the Office 2010 OPK DVD. 

 

4. From the Office 2010 OPK root directory, execute copytoserver.bat <destination>. 

Example: 

copytoserver "c:\WinBits\$OEM$ Folders\$1\Office 2010" 

Note: This will take some time copying the Office 2010 OPK bits to your distribution 
share. 

5. Using Windows Explorer, navigate to the c:\WinBits\$OEM$ Folders\$1\Office 
2010\Office14 folder. 
 

6. Delete the x64 folder. 
 

Note: Microsoft recommends to preinstall the 32-bit version of Office 2010 for both 
32-bit and 64-bit Windows 7 Operating Systems for ego system compatibility with 3rd 
party add-ins. In addition, by removing the x64 folder, you will reduce the overall 
footprint thus reducing deployment time. 

1.5: Add your Company Logo and customization files to 
your Distribution Share 

In this step, you will add your company logo to the distribution share. You will also add a 
custom background image and a custom user tile. You can create these files yourself. The 
following procedures will use the sample files from the Microsoft Windows OPK. These files 
are located in the following paths once you have installed the Microsoft Windows OPK: 

Filename Path 

backgrounddefault.jpg C:\Program Files\Windows OPK\Samples\OOBE\info 

usertile.bmp C:\Program Files\Windows OPK\Samples\OOBE\info 

fabrikam.png C:\Program Files\Windows OPK\Samples\OOBE\fabrikam 

It's recommended to use the sample files so you can see how they look. 

You'll need to provide an OEM logo for System Control Panel, 172 x 100 pixels, bitmap 
image. In our example, we'll reference fabrikam.bmp for this logo. 

To add your OEM logos and custom images to your distribution share, complete the 
following steps: 

1. On the technician computer, start Windows Explorer, and navigate to the 
distribution share (in our example, this is c:\WinBits\$OEM$ Folders). 
 

2. Using Windows Explorer, create the following folder structure: 

C:\WinBits\$OEM$ Folders\$$\system32\oobe\info 

3. Copy your OEM logo for OOBE to the 
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C:\WinBits\$OEM$ Folders\$$\system32\oobe\info folder. 

Note: In our example, the logo filename is fabrikam.png, a 32-bit portable network 
graphics (.png) file; 240x100 pixels. 

4. Using Windows Explorer, create the following folder structure: 

C:\WinBits\$OEM$ Folders\$$\system32\oobe\info\ backgrounds 

5. Copy the backgrounddefault.jpg file to the 
C:\WinBits\$OEM$ Folders\$$\system32\oobe\info\backgrounds folder. 
 

6. Copy the usertile.bmp file to the 
C:\WinBits\$OEM$ Folders\$$\system32\oobe\info folder. 
 

7. Copy your OEM logo for the System Control Panel to the 
C:\WinBits\$OEM$ Folders\$$\system32\oobe\info folder. 

Note: In our example, the logo filename is fabrikam.bmp, 172 x 100 pixels, bitmap 
image. 

Step 2.0: Design a Windows 7 
Installation 
In this step, you will design a custom Windows 7 installation using Windows System Image 
Manager (Windows SIM). The installation will include several OEM customizations and will 
also boot into audit mode, which will allow you to further customize your installation. The 
key tools you will use in this step are Windows System Image Manager (SIM), an answer 
file and Oobe.xml. 

Disk Configuration Support 

For Windows 7, Windows Setup now supports creating multiple partition types. By default, 
Windows Retail Setup will create two partitions: a system partition and an operating system 
partition. This configuration provides support for Windows BitLocker™ Drive Encryption as 
well as other performance benefits in Windows 7. For this step, you will build a single 
partition installation and later deploy the image onto a two-partition configuration (three 
partitions if Windows Recovery is included). 

2.1: Create an answer file 

In this step, you will create a new answer file.  For this step, a Windows 7 catalog is 
necessary. A catalog file (.clg) is a binary file that contains the state of all the settings and 
the packages in a Windows image. 

1. On your technician computer, click Start, point to Programs, point to Microsoft 
Windows OPK, and then click Windows System Image Manager. 

2. On the File menu, click Select Windows Image. 

3. In the Select a Windows Image dialog box, select Catalog files from the Files 
of type list.  
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4. Browse the DVD to \Sources folder, select Install_Windows 7 Ultimate.clg 
and then click Open. 

 

5. On the File menu, click New Answer File. 

2.2: Open a Distribution Share 

In step 1.0, a sample distribution share was created on your local hard drive (C:\Winbits). 

1. In Windows SIM, click Select a Distribution Share. 

2. Browse to C:\Winbits. 

3. Click Open. 

2.3: Add and configure Windows settings 

In this step, you will define the basic disk configuration. 

1. In the Windows Image pane of Windows SIM, expand the Components node to 
display available settings. 

2. On the expanded list of components, add the following components to your 
answer file by right-clicking the component and then selecting the appropriate 
configuration pass. 
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Component  

Configuration 

Pass  

Microsoft-Windows-Deployment\Reseal oobeSystem 

Microsoft-Windows-International-Core-WinPE windowsPE 

Microsoft-Windows-Setup\DiskConfiguration\Disk\CreatePartitions\ 
CreatePartition 

windowsPE 

Microsoft-Windows-Setup\DiskConfiguration\Disk\ModifyPartitions\ 
ModifyPartition 

windowsPE 

Microsoft-Windows-Setup\ImageInstall\OSImage\InstallTo windowsPE 

Microsoft-Windows-Setup \UserData windowsPE 

3. All the settings that you added must appear in the Answer File pane. Select and 
configure each setting as specified below. This is an example; you can modify 
what you want. 

Component  
Value  

Microsoft-Windows-International-Core-WinPE InputLocale = en-US 

SystemLocale = en-US 

UILanguage = en-US 

UserLocale = en-US 

Microsoft-Windows-International-Core-
WinPE\SetupUILanguage 

UILanguage = en-US 

Microsoft-Windows-Setup UseConfigurationSet = True 

Microsoft-Windows-Setup\DiskConfiguration WillShowUI = OnError 

Microsoft-Windows-Setup\DiskConfiguration\Disk DiskID = 0 

WillWipeDisk = true 

Microsoft-Windows-
Setup\DiskConfiguration\Disk\CreatePartitions\CreatePartition 

Extend = true 

Order = 1 

Type = Primary 

Microsoft-Windows-Setup 
\DiskConfiguration\Disk\ModifyPartitions\ModifyPartition 

Active = true 

Format = NTFS 

Label = WIN7_OS 

Letter = C 

Order = 1 

PartitionID = 1 

Microsoft-Windows-Setup\ImageInstall\OSImage\ WillShowUI = OnError 
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Microsoft-Windows-Setup\ImageInstall\OSImage\InstallTo DiskID = 0 

PartitionID = 1 

Microsoft-Windows-Setup \UserData AcceptEula = true 

Microsoft-Windows-Setup \UserData\ProductKey Key =  

Note   Use a product key to 
determine which edition of Windows 
is installed on a system. Royalty 
OEMs will use assigned product keys 
for the edition of Windows 7 they 
are assigned too and System Builder 
can use a product key from their 
Windows inventory which 
corresponds to the edition of 
Windows to be installed. The 
purpose to enter a product key is to 
automate the installation of 
Windows and to avoid being 
prompted to enter a product key. 
You must not activated this product 
key if you use one from existing 
Windows inventory in order for it to 
be sold.  

WillShowUI = OnError 

Microsoft-Windows-Deployment\Reseal ForceShutdownNow = false 

Mode = Audit 

2.4: Add OEM Customizations 

In this step, you will define a collection of customization allowances that take advantage of 
some differentiation, performance, and monetization opportunities. You'll also add a 
command to preload Microsoft Office 2010. To implement customizations you will add 
additional unattend settings to your answer file. In addition, you must create a custom 
content file called oobe.xml to include the following customizations: 

 System Properties (Shell-Setup component) 
 Performance Information and Tools (PerfCenterCPL component) 
 Internet Explorer (IE_InternetExplorer component) 
 Desktop Background (Shell-Setup component) 
 OEM Welcome Center (Shell-Setup component) 

1. In the Windows Image pane of Windows SIM, expand the Components node to 
display available settings. 

2. On the expanded list of components, add the following components to your 
answer file by right-clicking the component and then selecting the appropriate 
configuration pass. 

Component  Configuration Pass  

Microsoft-Windows-Deployment\RunSynchronous\RunSynchronousCommand auditUser 
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Microsoft-Windows-Deployment\RunSynchronous\RunSynchronousCommand auditUser 

Microsoft-Windows-IE-InternetExplorer\FavoritesList\FavoriteItem Specialize 

Microsoft-Windows-IE-InternetExplorer\StartPages\StartPage Specialize 

Microsoft-Windows-IE-InternetExplorer\StartPages\StartPage Specialize 

Microsoft-Windows-PerfCenterCPL\WindowsExperienceIndexOemInfo oobeSystem 

Microsoft-Windows-Shell-Setup\OEMInformation Specialize 

3. All the settings that you added must appear in the Answer File pane. Select and 
configure each setting as specified below. This is an example; you can modify 
what you want. 

Component  
Value  

Microsoft-Windows-
Deployment\RunSynchronous\RunSynchron
ousCommand 

Description = Microsoft Office 2010 

Order = 1 

Path = c:\Office 2010\oemsetup.en-us.bat 

WillReboot = Never 

Microsoft-Windows-
Deployment\RunSynchronous\RunSynchron
ousCommand 

Description = Microsoft Office 2010 Cleanup 

Order = 2 

Path = cmd.exe /c rd /s /q "c:\Office 2010" 

WillReboot = Never 

Microsoft-Windows-IE-
InternetExplorer\FavoritesList\FavoriteItem 

FavID = Favorite1 

FavTitle = Fabrikam 

FavURL = http://www.fabrikam.com 

Microsoft-Windows-IE-
InternetExplorer\StartPages\StartPage 

StartPageKey = Home page 1 

StartPageURL = http://www.fabrikam.com 

Microsoft-Windows-IE-
InternetExplorer\StartPages\StartPage 

StartPageKey = Home page 2 

StartPageURL = http://www.fabrikam.com/support 

Microsoft-Windows-Shell-Setup 
\OEMInformation 

HelpCustomized = false 

Logo = c:\Windows\System32\OOBE\Info\fabrikam.bmp 

Manufacturer = <company name> 

SupportHours = <support hours> 

SupportPhone = <support number> 

SupportURL = <support URL> 

Microsoft-Windows-
PerfCenterCPL\WindowsExperienceIndexOe
mInfo 

HardwareUpgradeURL = http://www.fabrikam.com/upgrade 

Logo = c:\Windows\System32\OOBE\Info\fabrikam.png 



Creating a Windows 7 Hard Disk Recovery Solution 
 

Shiningintl Technology     www.shiningintl.com Page 14 
 

Note: The parameter descriptions for the oemsetup.ll-cc.bat file are shown in 
the following table. The ll-cc is the two-letter abbreviation for the language and 
country or culture. In our example we are preloading Microsoft Office 2010 in 
United States, English. For more information on preloading Microsoft Office 
2010, refer to the Microsoft Office 2010 OPK. 

Parameter Description 

Referral=ReferralCode Stores the provided OEM referral code in the registry. 

NoOfficeStarter=1 Prevents copying Office Starter 2010. Use this option only when 

necessary. For more information, contact your Microsoft account 

manager. 

NoOffice=1 Prevents copying of Office 2010. Use this option only when necessary. 

For more information, contact your Microsoft account manager. 

x64 Preloads the Office 2010 64-bit edition instead of the 32-bit version.  

Caution: Do not preload the 64-bit version unless that version is 

specifically required. 

2.5: Customize Windows Welcome (OOBE) 

In this step, you will customization Windows Welcome. You will create a custom content file 
called oobe.xml. Oobe.xml is a content file that you can use to collect text, images, and 
settings for customizing Windows Welcome, the out-of-box experience for Windows 7. The 
Oobe.xml file can also be used to define OEM-specified images for the first user tile and for 
the desktop background.  

1. Using a text editor, like Notepad, create a file called Oobe.xml. Enter the 
following text:  

<?xml version="1.0" encoding="utf-8" ?> 
<FirstExperience> 
 <oobe> 
  <oem> 
   <name>Fabrikam</name> 

   <logopath> c:\Windows\System32\OOBE\Info\fabrikam.png</logopath> 
   <OutOfBoxBackground>true</OutOfBoxBackground> 

   <usertilepath> c:\Windows\System32\OOBE\Info\usertile.bmp</usertilepath> 
  </oem> 
 </oobe> 
</FirstExperience> 

 
2. Save the Oobe.xml to the 

C:\Winbits\$OEM$ Folder\$$\System32\OOBE\Info folder. 
 

For more information on Oobe.xml customization options, refer to the OEM Preinstallation 
Kit (OPK) User's Guide. 

2.6: Validate the answer file 

In this step, you will validate the settings in your answer file and save them. 



Creating a Windows 7 Hard Disk Recovery Solution 
 

Shiningintl Technology     www.shiningintl.com Page 15 
 

1. In Windows SIM, click Tools, and then click Validate Answer File. 
The setting values in the answer file are compared with the available settings in 
the Windows image. 

2. If the answer file validates successfully, a "success" message appears in the 
Messages pane. Otherwise, error messages appear in the same location. 

3. If an error occurs, double-click the error in the Messages pane to navigate to the 
incorrect setting. Change the setting to fix the error, and then revalidate by 
returning to step one. 

4. On the File menu, click Save Answer File. Save as 
c:\unattends\Win7Recovery.xml. 

2.7: Create a configuration set 

In this step, you create a configuration set that will gather all the resource files that you 
specified in your answer file into one location.  

1. In Windows SIM, on the Tools menu, select Create Configuration Set. 
The Create Configuration Set window opens. 

 

2. For the target folder, browse to C:\WinBits, then type ConfigSets\ConfigSet1, and 
then click Open. 
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3. For the OEM folder, browse to C:\WinBits\$OEM$ Folders and click Open. 

 

4. In the Create Configuration Set window, click OK. 
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5. Click Yes when asked if you want to create the folder. 

 

6. Click OK. 

 
 

Windows SIM will create the following configuration set folder structure on your 
C:\WinBits\ConfigSets\ConfigSet1 directory. 

$oem$ 

AutoUnattend_Files 

AutoUnattend.xml 

Important: Whenever you make a change to the $OEM$ Folders, Out-of-Box Drivers, 
Packages, or the Win7Recovery.xml answer file, you'll have recreate the configuration 
set in order for changes to take effect. 
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Step 3.0: Build a Reference Computer 
In this lab, you will build a reference computer using the Windows 7 Product DVD and your 
configuration set created in Lab 2.0. A reference computer is a fully assembled computer 
that represents the computer you want to deploy in your manufacturing environment. After 
Windows Setup completes the installation, the computer will reboot into Audit Mode. In 
Audit Mode, you have the option to add additional customizations. The key tools you will use 
in this lab are Windows Setup, Sysprep, Windows PE and ImageX.  

Why Use Sysprep? 

As an OEM, you are required to reseal the new installation by using the System Preparation 
(Sysprep) tool. The Sysprep tool removes system-specific information and resets the 
computer, so that the next time the computer starts, your customers can accept the 
Microsoft Software License Terms and add user-specific information. 

Important: If you intend to transfer a Windows image to a different computer, you must 
run the sysprep command with the /generalize option, even if the computer has the 
same hardware configuration. The sysprep /generalize command removes unique 
information from your Windows installation, which enables you to reuse that image on 
different computers. If you want to install a Windows image to computers that have the 
same hardware configuration, you can preserve the device-drivers installation in a Windows 
image by using the PersistAllDeviceInstalls setting in your answer file. For more information, 
see the Unattended Windows Setup Reference (Unattend.chm).  

Why Use Audit Mode? 

There are two modes that Windows can boot to during an unattended installation: audit 
mode and Windows Welcome (also called Out-of-Box Experience). Audit mode is the ideal 
environment for you to make additional changes and configurations to a Windows 
installation before shipping that computer to its final destination. Audit mode enables you to 
install additional applications, device drivers, run scripts, or apply updates to a Windows 
installation. After you complete your additional configurations in audit mode, you can 
configure the computer to boot to Windows Welcome on next boot by using the Sysprep 
command-line tool. Windows Welcome is designed for end users to configure their computer, 
according to their requirements. Audit mode also allows pending actions, like language pack 
installation, to complete potentially saving time during Windows Welcome. 

3.1: Copying the Configuration Set to the USB Flash Drive 

In this step, you will prepare the USB flash drive with the answer file to perform an 
unattended installation of Windows 7 including the OEM customizations and Microsoft Office 
2010. 

1. On the technician computer, using Windows Explorer, navigate to 
C:\WinBits\ConfigSets\ConfigSet1. 
  

2. Insert the USB flash drive (UFD) to the technician computer. 
 

Important: Ensure the USB flash drive is formatted and empty. 
  

3. Copy the $oem$, and AutoUnattend_Files folders and the AutoUnattend.xml file to 
the root directory of the USB flash drive. 
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3.2: Build a reference installation 

In this step, you will build a reference installation using the Windows 7 Product DVD and the 
USB flash drive which contains the configuration set and answer file. The reference 
computer is the PC that you will load Windows 7 and Microsoft Office 2010. Once completed, 
an image of the reference PC will be captured to make available to deploy on multiple 
systems. The reference PC is the computer that contains your master image. 

1. On the reference computer, insert the Windows 7 Product DVD and the USB flash 
drive then boot the computer. 
 
Note: Ensure the BIOS boot order is set to boot from thee DVD-ROM 1st. After Setup 
completes the system will boot into audit mode. 
 

2. Validate that all your customizations were applied. 
 
Note: Some OEM Customization will not appear audit mode, for example Windows 
Welcome. You'll notice Microsoft Office 2010 is preloaded and the Microsoft Office 
2010 OPK is removed from the c:\Office 2010 folder. 

3.3: Add Additional Customizations 

In this step, you can add additional customizations while in audit mode. Depending on the 
complexity of your systems, Audit Mode may be the most efficient method for adding 
customization such as applications that require an attended installation. 

3.4: Prepare the image using Sysprep 

In this step, you will run the Sysprep tool to generalize the image prior to capturing an 
image. By default while in Audit Mode, the System Preparation Tool dialog is started. 

1. When you are done customizing the installation reseal the computer. From the 
System Preparation Tool dialog, System Cleanup Action drop-down list, select 
Enter System Audit Mode. 
 

2. Select Generalize checkbox. 
 

3. From the Shutdown Options drop-down list, select Shutdown. 
 

4. Click OK. 
 
Important: You cannot capture an image unless the reference computer has been 
Sysprep /generalized. Refer to http://support.microsoft.com/kb/935467 for more 
information. 

3.5: Capture an audit image of the installation 

In this step, you will capture an audit image of the new installation and store it onto your 
USB hard drive. This image will become your base image that will be used throughout the 
remaining labs.  

1. On your technician computer, copy ImageX from "C:\Program Files\Windows 
OPK\Tools\x86\"imagex.exe to the root of the USB hard drive. 
 

2. On the reference computer, plug in the USB hard drive. 
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3. Boot the reference computer using your Windows 7 OPK DVD. When the system 

boots, press any key when prompted to boot into Windows PE. 
 

4. From the Windows PE command prompt, use the ImageX command with the 
/capture option to capture an image of the installation and save it to the USB hard 
drive. 
 
Example:  e:\imagex /capture c:\ e:\w7Audit.wim "Windows 7 Audit" 
The e: drive is the USB hard drive in this example. 

5. After capture is complete, restart the computer.  

3.6: Prepare the OOBE image using Sysprep 

In this step, you will run the Sysprep tool to generalize the image to OOBE in order to 
capture the OOBE image. The OOBE image will be used as the factory image used in the 
recovery solution. 

1. Once the computer has reached the desktop, from the System Preparation Tool 
dialog, System Cleanup Action drop-down list, select Enter System Out-of-Box 
Experience (OOBE). 
 

2. Select Generalize checkbox. 
 

3. From the Shutdown Options drop-down list, select Shutdown. 
 

4. Click OK. 

3.6: Capture an OOBE image of the installation 

In this step, you will capture an OOBE image of the new installation and store it onto your 
USB hard drive. This image will become your base image that will be used throughout the 
remaining labs.  

1. On the reference computer, plug in the USB hard drive. 
 

2. Boot the reference computer using your Windows 7 OPK DVD. When the system 
boots, press any key when prompted to boot into Windows PE. 
 

3. From the Windows PE command prompt, use the ImageX command with the 
/capture option to capture an image of the installation and save it to the USB hard 
drive. 
 
Example:  e:\imagex /capture c:\ e:\install.wim "Windows 7 OOBE" 
The e: drive is the USB hard drive in this example. 

4. Change directory to the USB hard drive. 
 

5. Rename install.wim to install.txt by typing the following command: 
 
ren install.wim *.txt 
 

6. Type the following command from the command prompt: 
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md recovery\recovery\windowsRE 
 

7. Type the following command to move recovery.txt to the recovery folder. 

move install.txt recovery\recovery\windowsRE 

8. Type the following command to capture recovery.txt back to a wim. 

imagex /capture /compress fast e:\recovery e:\recovery.wim "End User Recovery" 

 

Note: This will take some time to complete. 

9. After capture is complete, shutdown the computer.  
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Step 4.0: Automating of the 
implementation of Windows 7 with 
recovery solution 
In this step, you'll create batch files to deploy the images using ImageX on the USB hard 
drive. 

1. Ensure you have the USB hard drive connected to the technician computer. 
 

2. Execute Notepad. 
 

3. Copy and paste the following text to Notepad: 

@echo off 

diskpart /s confighd.txt 

imagex /apply w7audit.wim 1 c:\  

c:\windows\system32\bcdboot.exe c:\windows 

md r:\recovery\windowsre 

imagex /apply recovery.wim 1 r:\ 

ren r:\recovery\windowsre\install.txt *.wim 

copy c:\windows\system32\recovery\winre.wim r:\recovery\windowsre 

c:\windows\system32\reagentc.exe /setreimage /path r:\recovery\windowsre /target 

c:\windows 

c:\windows\system32\reagentc.exe /setosimage /path r:\recovery\windowsre /target 

c:\windows 

diskpart /s configHD2.txt 

 
4. Save the text to DeployWindows7.cmd and exit Notepad. 

 
5. Execute Notepad. 

 
6. Copy and paste the following text to Notepad: 

select disk 0 

clean 

create partition primary size=500 

select partition 1 

active 

format fs=ntfs label="System" quick 

create partition primary size=6000 

select partition 2 

format fs=ntfs label="Recovery" quick 

assign letter = R 

create partition primary 

select partition 3 

format fs=ntfs label="OS" quick 

assign letter = C 

exit 

 
7. Save the text to configHD.txt and exit Notepad. 

 
8. Execute Notepad. 
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9. Copy and paste the following text to Notepad: 

select disk 0 

select volume 2 

set ID=27 

exit 

 
10. Save the text to configHD2.txt and exit Notepad. 
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Step 4.1: Deploying Windows 7 using 
ImageX 
This step is used to deploy Windows 7 using the images you just captured from the 
reference computer. You will redeploy the images to the master computer. You can deploy 
the images to the master computer or any other computers you assemble. 

In the step 4.0 you created a batch file called DeployWindows7.cmd, which will do the 
following: 

 Clean and partition the hard drive 
 

 Apply the Windows 7 Audit image and the Windows RE image using ImageX 
 

 Copy the recovery.wim to the recovery partition 
 

 Hide the recovery partition 

To deploy Windows 7 with image files perform the following tasks: 

1. Connect the USB hard drive to the master computer. 
 

2. Boot the master computer using the Windows 7 OPK DVD. 

Note: Ensure that the computer’s BIOS is configured to boot the DVD-ROM first. 

3. From the Windows PE command prompt, change directory to the USB hard drive. 
 

4. Type the following command to deploy the Windows images: 

DeployWindows7.cmd 

5. When the installation finish, type Exit and reboot.  
 

6. The PC will boot in Audit mode. 
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Step 4.2: Testing the recovery solution 
via the Recovery in Control Panel 

In this step, you will test the recovery solution via the Recovery in Control Panel. 
Recovery in Control Panel includes several options that can help you recover your 
computer from a serious error. In the Advanced recovery methods, there are two 
methods for recovery. The first method replaces everything on your computer, 
including Windows and all of your personal files, with a backup or a recovery image. 
The second method reinstalls Windows in its entirety. You will use the 2nd option to 
recover using the image you captured. 

Perform the following steps to test the recovery solution via the Recovery in Control 
Panel: 

1. On the master computer, remove the DVD-ROM and USB hard drive and start the 
computer. 

2. Execute Sysprep with the OOBE option and restart the PC. 

3. Start the destination computer and complete the Out of Box Experience (OOBE). 

4. Press the Start Button and in the search input area, type "Recovery".  

 

5. From the search results, launch the Recovery control applet.  

6. Select the "Advanced recovery methods" option.  



Creating a Windows 7 Hard Disk Recovery Solution 
 

Shiningintl Technology     www.shiningintl.com Page 26 
 

 

7. Select "Reinstall Windows" option. 

 

8. Follow the on-screen instructions if you want to back up your files. Then, the 
computer will restart. 
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9. Verify that the computer starts in Windows RE.  
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10. From the System Recovery Options dialog box, select a language and keyboard 
layout. 

 

11. Click the Yes button to reinstall Windows using the image you placed in the 
recovery partition. 
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Note: By selecting Yes, Windows will begin the reinstallation of Windows using the 
recovery image you created. 
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12. Once the Windows Setup is complete, the PC will boot to OOBE.  Complete Windows 
Welcome. 

Note: If you create a backup prior to the restore, you'll have the option to restore 
the backup. 
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Step 4.3: Testing the recovery solution 
using the Advanced Boot Options 
The Advanced Boot Options menu lets you start Windows in advanced troubleshooting 

modes. You can access the menu by turning on your computer and pressing the F8 key 

before Windows starts. Accessing the Advanced Boot Options menu allows access to the 

Repair Your Computer option. By selecting the Repair Your Computer you'll be able to 

reach the System Recovery Options menu to access the recovery options. 

To access the Advanced Boot Options perform the following tasks. 

1. Turn on the master computer. 

2. Press F8 before Windows starts. 

 

Note: If Windows starts, you did not press F8 within the appropriate time allows.  

Shutdown the computer and try again. 

 

3. From the System Recovery Options dialog box, select a language and keyboard 

layout. 
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4. Select the user you created. 
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5. Select Reinstall Windows. 

 

6. Click the Yes button to start the reinstallation of Windows using the image you 

placed in the recovery partition. 
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A note about Windows.old 
Returning Windows to original settings doesn't completely delete everything on the 

computer. It deletes programs, but saves user files to the Windows.old folder on the root 

directory of the hard disk, which can be accessed after the reinstall completes. However, 

end users should still back up their files before using this method. For example, if and end 

user has encrypted files, they might not be able to access them after reinstalling Windows. 

If the end user has backed up their files and then restored them after reinstalling Windows, 

they can delete the Windows.old folder. 

 

 


